
 

Laboratory Assignment Number 2 for MEAM247 
Due by February 23, 2007 

 

Purpose: In this lab you will customize an elliptical machine to a team member’s physical dimensions. It is intended 
to better acquaint you with autoCAD/SolidWorks and the laser cutter. In addition, you will have a chance 
to design a simple mechanical system with a four bar linkage.   

Minimum Parts 
Required:

12”x18” acrylic sheet, 7 plastic shoulder bolts w/ matching screws. You may want small amounts of 1/8 
acrylic to make washers. Limited amounts of additional acrylic are available (or you may acquire your 
own if necessary). 

References: synthesis.pdf 

Part 1:  The standard elliptical machine 

Reading: Before starting this lab, read all of the assignment. Read linkages slides from MEAM 211.  

Background: An elliptical trainer (also cross trainer) is a stationary exercise machine 
used to simulate walking or running without causing excessive pressure 
to the joints, hence decreasing the risk of impact injuries. It is comparable 
to a treadmill in its exertion of leg muscles and the heart. However, 
because the user's limbs remain in continuous contact with the machine, 
its operation limits the dynamic loading of bones and joints to generally 
harmless levels. This non-impact aspect appeals to those with recent 
injuries, chronic knee problems, and the obese, who cannot tolerate a 
treadmill. [en.wikipedia.org/wiki/Elliptical_trainer] 
The elliptical machine can be thought of as a crank-rocker four-bar linkage designed 
to guide your foot to travel in a path that closely resembles an ellipse as you 
exercise.  Unfortunately this path can not be adjusted.  Tall persons like Dr. Kumar, 
and ‘not so tall’ persons like Dr. Yim are forced to exercise their legs following  
the same exact leg motion.  Even though Dr. Kumar’s  
natural leg strides are larger than Dr. Yim’s they 
are forced to execute the same foot path when 
they exercise on the elliptical.  This path may  
feel natural for most people of average 
size, but may feel awkward for Dr. 
Kumar and Dr. Yim.  Dr. Kumar is  
forced to take smaller strides than he’s used to and Dr. Yim has to take bigger strides than he usually takes 
when he walks.  Obviously the design of the elliptical machine is compromised.   
In this lab you will customize an elliptical machine to a team member’s dimensions in which the path of the 
elliptical machine will match as close as possible the actual stride of your legs during walking. 

Assignment: Complete the following exercises. 

 �� 1.1) Draw or take a picture of an elliptical machine and denote the crank, coupler, follower and frame. Take 
the important measurements of this machine and analyze the motion with the fourbar linkage program 
that has been provided to you in MEAM 211.  You can edit fourbario.dat and plug the values in 
there. 

 �� 1.2) While you are taking the picture of the elliptical machine, try it out. Note how far your legs must move. 
Measure the angles your joints take using your goniometer. Note how much the rest of your body 
moves. Are there any parts of this machine that are particularly badly designed? well designed?  Why is
each structural part of the machine there?  

In the report: Include a drawing of the of the elliptical machine with measurements and provide the plots as shown by 
fourbar_analysis.m 

Part 2: Design the linkage 
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Reading: synthesis.pdf from MEAM 211 

Goal: You will design a linkage that will match the path of your foot during exercise of the elliptical machine with 
the path of your foot during an actual walking motion. 

Assignment: Complete the following exercises. 

 �� 2.1)  Read the MEAM 211 four-bar analysis and synthesis documents. 

 

 

Figure 1: A stick figure of legs is shown in three extreme positions during stride: minimum (blue), neutral 
(green) and maximum (red).  The minimum position is defined as the position of the leg when the joint angles 
are smallest.  In the neutral position the joint angles of the hip and knee are 0 degrees and in the maximum 
position the joint angles are greatest. Angles are measured in the local frame. 

 �� 2.2) In the previous lab you have plotted the path of your heel over time during a natural walking stride.  For 
three position synthesis (described later) you will need to pick three different positions of your foot.  For 
example you could take the three positions of the heel as shown in Figure 1.   

 

 

Figure 2: Plot of leg with platform attached to the foot in three different positions. 

 �� 2.3) The bar that the user will be standing on will be called the platform. See Figure 2. The platform will give 
you the three positions of the coupler from which you will determine the fourbar linkage for your 
customized elliptical machine.  The position of the ankle gives you three positions of a point on the 
platform, but not the angle of the platform relative to the ground (or heel).  You will need to determine 
the three angles that will allow you to create a feasible elliptical machine.  

 �� 2.4)  After you have designed your fourbar linkage, analyze and plot this linkage by using 
fourbar_analysis.m.  Compare the output motion of the platform with the plotted path taken from 
the previous lab. Iterate between part 2.2 and 2.4 to get your four bar linkage to follow actual path of the 
foot as close as possible. Plot both the motion of the foot from the four bar and the actual data on one 
graph. 

In the report: Include the plot from 2.4, the linkage design, the angles of the three positions from the measured leg data. 
Discuss how you chose the platform angles. 
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Part 3:  Making the prototype 

Background: Prototyping is an important part of the design process.  It allows you to quickly check your design for 
feasibility, functionality manufacturability and other factors for very cheaply and gives you a physical 
intuition of the kinematics of the device.  

In addition to physical intuition, semi-functional mockups are often used to explain to concepts to people (to 
venture capitalists if you’re pitching an invention, management of a company you may be working at, 
customers who may want to buy a machine etc.)  In these cases, besides getting the kinematics right, there are 
several other important aspects of the prototype. 

• Aesthetics. The device should look appealing. 

• Robustness. Having the device fall apart during a demonstration is disastrous. 

• Features. The device should have a reason for everything on it.  

 
Figure 4: Photograph of an elliptical machine prototype.  Note that the main frame serves as a main stand and 
the body of the person is rigidly attached to this stand. 

Assignment: Complete the following exercises. 

 �� 3.1) Using the previous section of this lab you will build a functional mockup of a new an improved elliptical 
training device.  It must, at a minimum. 

• allow constrained motion of the legs in some optimal pattern (you choose what optimal means) 

• be able to fit in a 11” x 35” x 35” box, 

• be able to show the intended motions for a miniaturized person using it  (e.g. a working four bar 
linkage). 

Based on your observations of current elliptical machines (or other exercise machines you may have seen), 
you may wish to add functionality to your device. 
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��  3.2) You will present your device in a 2 minute presentation to the class as if you are selling the concept to 
potential investors.  You should highlight the features that make your device unique, useful and desirable.

Professor Kumar will choose one or two designs he likes best, which will receive a prize and be displayed 
in the MEAM display case outside Town229. 

�� Extra Credit: Most exercise machines can be adjusted to a person’s dimensions by adjusting prismatic or 
revolute joints to change the height or angle of the seat for example.  The elliptical machine however does not 
offer such a feature (as far as we know).  Can you add a joint in which the path of the elliptical could be tuned 
to fit your natural strides?  Build a prototype of your design.  Are there any elliptical machines out there with 
such a feature. Are there any patents on such a design? 

In the report: Include pictures of your creation, the important properties chosen, a description of the features of your design 
and the rationale for each. Describe what you have chosen for your optimality metric in section 3.1. Include 
print out of CAD files used to cut the pieces and the scale (ratio) of the model versus reality. 

Appendix:  Sample linkage using the laser cutter 

Background: There is a Universal Laser Systems laser cutter in in the Towne Rm169 MEAM machine shop. There will be a 
signup sheet for hours from 9AM-5PM with 1 hour slots.  Please sign up for only 1 hour at a time. Come 
prepared with your finished files. If there is no sign up sheet, usage of the laser cutter will be first come first 
served.  The instructions below are a sample of how to create a four bar linkage on the laser cutter. 

 �� A.1) Draw the parts using AutoCAD. AutoCAD is available on all CETS computers in the computer 
labs. Use the following steps to create your drawing: 
1. From the “File” menu select “New”. 
2. Select “English Units” and a new drawing area will open. The laser system requires all units in 

English. 
3. Go to the “Format” menu and select “Lineweight”, set the line weight to 0.002”. The laser system 

requires that the line width (weight) be less than 0.008” for vector cutting. 
4. Go to the command prompt at the bottom of the drawing window, enter the following commands, 
  _rectang 
  0,0 
  12,-12 
 This will draw a rectangular box that defines the maximum cutting area of the acrylic sheet that you 

have. Note for future reference, the maximum cutting area of the laser system is 18”x32”. The line 
color of the rectangle should be set to white, the laser will not cut any lines in your drawing that are 
white, they will be for reference only. 

5. Go to the “Format” menu and select “Color”, set the color to red. As noted in step 4, the laser will not 
cut any line that is drawn in white. By changing the line color to red, the laser can be configured to 
cut any part drawn in red. 

6. Begin to create your linkage parts on the drawing. See Figure 1 for an example of linkage 
components, this is only a example, you don’t need to use these parts dimensions. A couple of things 
you should keep in mind when laying out your parts. First is to locate the parts strategically to 
conserve your 12”x12” material. . It is recommended that the upper left corner of the first part in your 
drawing be located at 0.75”,-0.75”. Note that there is a discrepancy of ~0.2” between the Y axis on 
your drawing and the Y axis on the laser system (no X axis discrepancy). If you have your part 
located 1.0” from the X axis (the Y axis setting), the laser will actually begin cutting at ~0.8” from 
the X axis.  

7. When drawing the holes for the pivot points, make all pivot holes 0.215” in diameter to fit the plastic 
shoulder bolts that will be provided. The head diameter of the shoulder bolt is 0.4”. Depending on 
how you design the four bar linkage you may need the links to ride on top of each other. You may 
need spacers to give clearance for the shoulder bolts. These spacers are essentially like washers with 
an ID made to fit the shoulder bolt.  
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8. Print out your drawing to include in the lab report. 

 �� A.2) Cut the parts on the X-660 laser system. Note that you will need to have your AutoCAD parts 
file (“name”.dwg) saved on floppy disc, or transferred on the network. 
 
1. Start AutoCAD on the computer connected to the laser system and open your parts file via the floppy 

drive.  
VERIFY THAT ALL PARTS THAT ARE TO BE CUT ARE DRAWN WITH RED LINES, 
the laser will be setup to vector cut only those lines that are in red. 

2. Turn on the laser system, the switch (yellow) is located on the lower right side of the laser, bottom 
towards the back. 

3. In AutoCAD, go to the “File” menu and select “Page Setup”. 
4. Select the “Layout Settings” tab and only set the following parameters, all others should remain the 

same, 
  Plot area - Extents 
  Plot scale - Scale - 1.1 

5. Select the “Plot Device” tab and set the following parameters, 
  Plotter configuration -  Name - X-660.pc3 
  Plot style table – Name – acad.ctb 

6. On the same “Plot Device” tab, select the “Properties” icon and select the “Device and Document 
Settings” tab. Select the “Custom Properties” icon. 

7. Select the “Laser Settings” tab. Set the “Pen Mode” for red to “VECT” by clicking on the icon. The 
“Pen Mode” for all other colors should be set to “SKIP” (including black which applies to the white 
lines in AutoCAD), this is default. 

8. Highlight the red settings by clicking once on the word “red”. Set the following parameters for red, 
Power – 100% 
Speed – 3.0% (note for thicker plastics this number will need to be smaller) 
PPI – 500 PPI 
then select the “Set” icon, all parameters for red should then be updated. Select the OK 
 icon at the bottom of the window. 

9. In “Plotter Configuration Editor – x.660.pc3”, select OK. 

0.563 OD  
0.215 ID 
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10. In “Page Setup-Model” select the “Plot” button. This will download your plot file to the laser system. 
Press the NEXT FILE button on the laser panel to verify that your file has downloaded correctly, 
specifically check the power setting and feed rate (100%, 3.0%,), if these are zero then the file didn’t 
download correctly. Check the color, pen thickness and try to download again. (If problems persist, 
see the TA). 

11. The laser now needs to be setup to cut your material. Open the lid on the laser and place your 
12”x12” acrylic sheet on the bed with upper left corner touching the scales. Make sure the material is 
resting on the four flat washers provided, this will allow heat to dissipate from under the material 
when cutting. 

12. Press the Z button on the laser front panel. The laser head will move to the left for Z axis setup. Press 
the SELECT button once to get 0.01” resolution. Place the height gage under the laser head, MAKE 
SURE THE GAGE IS NOT DIRECTLY UNDER THE CAP SCREW STICKING OUT OF 
THE LASER HEAD. Press the <> buttons until the laser head is at the height that just pushes away 
the gage. Once complete, press Z and the head will return to its home position. 

 
13. Move the piece to the lower left corner of the bed. This is the default location that AutoCAD will plot 

to (see the Plot Preview for where the laser will cut). 
14. IMPORTANT Turn on the exhaust fan, the switch is on the wall behind the laser. Press the START 

button on the laser and the cutting will begin. When the laser is done cutting it will make an audible 
beep and the laser head will return to the home position. Turn off the exhaust fan and remove your 
parts. 

15. You may wish to wipe the parts with a damp cloth to remove smoke and particles from the ablated 
plastic. 

  Assembling the linkage   

The links are joined using the plastic shoulder screw and the mating plastic screw. The plastic screw is 
self-tapping into the shoulder screw so you shouldn’t screw and unscrew it too many times as it will become 
loose. 

Notch is flush 
with head 

Grading 

6600%% Implementation. This will include: 
• Functionality (how well it follows your optimality criterion from 3.1).  
• Robustness 
• Aesthetics 

20% Presentation. February 23rd at ME211 recitation and 26th at  ME247 lecture. 

20% Report. due February 23th 2007 at ME211 recitation  
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Lab #2 

Time Summary 
Be sure to turn this in with your lab report 

 
This information is being gathered solely to produce statistical information to help improve the lab 
assignments. 
 

Part 1 Preparing Outside of the lab ____________    In the lab working this part__________ 

Part 2 Preparing Outside of the lab ____________    In the lab working this part__________ 

Part 3 Preparing Outside of the lab ____________    In the lab working this part__________ 

Report Preparing the Lab Report ______________ 
 


